
 

ABR 求閾值：技術與經驗分享 

關於這堂課 

聽性腦幹反應（ABR）又稱聽性誘發電位（AEP），係以聲音刺激周邊聽覺器

官，引起大量神經同步放電，以遠場電極記錄電位變化的技術。ABR 在臨床上

相當常用，經常當成神經學診斷或尋找聽覺系統閾值的工具。 

ABR 記錄到的電位變化受到諸多因素影響，例如刺激音的選用、記錄參數的

調整等。相同受測者在相同生理情況下以相同儀器施測 ABR，也可能因為種種

因素而得到全然不同的結果。ABR 的各項參數一直都是值得注意的細節，尤其

臨床記錄到的結果需要與期刊文獻上發表的資料相比較時，忽視這些細節可能

導致嚴重誤判。 

可能有些聽力師多年來始終沿用購入儀器時，由廠商設定的施測及記錄參數；

也有些聽力師在實務經驗累積之下，逐漸摸索出自己的一套設定。各醫療院所

的聽力師或許私下偶爾交流這些參數設定，但是很少能有機會可以有更多聽力

師齊聚一堂互相分享心得，相當可惜。 

自己的專業靠自己提昇，與其等別人提出分享，不如自己先來講。ABR 施測

記錄參數在推敲之間，不見得有所謂對錯，也往往沒有「最好的辦法」，姑且

先敞開心胸把成見放一邊，聽聽我的故事：我在什麼樣的環境中，考慮了哪些

事項，做出何種決定。然後再想想，你在你的環境中，又會考慮哪些事項，做

出何種決定？下一次，你也可以說出你的 ABR 故事，而且你還會發現，你的

ABR 報告更有把握，也更快完成。 

先提醒各位：本次分享偏重於實務技術與經驗，吊書袋的事情會刻意減少，

以免分散關注的焦點。雖然本次分享的內容中，只有若干廠牌儀器的資訊，但

是所有的內容都可以用於各家廠牌；誠摯邀請各位返院後抽空拿出儀器的操作

說明讀一讀，或者請儀器代理廠商針對需要調整的地方多做說明。 

關於我 

我是林克寰，在二林基督教醫院擔任聽力師。我是院內唯一的聽

力師，包辦所有聽力師該做的事：新生兒聽力篩檢與確診及個案管

理、體檢聽力篩檢、門診聽力檢查、平衡眩暈檢查、誘發電位檢查、

輔具評估與效益驗證等。 
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我是那種工作上愛講話也愛玩的聽力師，很幸運地，我的主管一向相當縱容

我在常規之餘，多做點額外的嘗試。本院的誘發電位儀器只有一組，是 Cadwell
的 Sierra Wave，屬於神經科財產，耳鼻喉科只有兩個診次的時段可以至腦波室

借用；時段限制意味著我必須更把握時間，如何做得更快更好，

自然成為我自赴任首日以來不曾停止思考的議題。 

我的部落格位於 http://Jedi.org/blog/，不定期發表與聽力學

相關的心得，當然也歡迎隨時來信指教：JediLin@Gmail.com 

ABR 最高指導原則 

施測 ABR 之前，首先要弄清楚，現在這個 ABR 要用來做什麼。要弄清楚的

並不是單純說「求閾值」或「神經學診斷」而已，而是要先決定好，ABR 記錄

到的結果中，有哪些資訊是重要、一定要有的，又哪些資訊可有可無，弄清楚

後纔知道該怎麼決定參數，獲得我們想要的資訊。 

在同一次 ABR 檢查當中，也可能分成若干階段，各有其目的，表示你的 ABR
施測過程當中，需要隨著資訊蒐集的進度，變更不同的參數搭配。不要妄想一

招半式打天下，要想著見招拆招。 

千變萬化的 ABR 當中，有沒有什麼核心關鍵，放諸天下皆準？聽力師界著

名的案頭工具書《Audiologists' Desk Reference》作者 James W. Hall, III 對於 ABR
如何施測有句座右銘，值得分享： 

若有任何做得出好結果的辦法──就做吧！ 

這句座右銘是「成人版」，他另外還有一句「嬰幼兒版」如是說： 

若有任何做得出好結果的辦法──就快快做吧！ 

換而言之，成人 ABR 施測的最高指導原則是要做得好，嬰幼兒 ABR 施測的

最高指導原則是要做得又快又好，畢竟嬰幼兒能夠乖乖配合的時間極其有限，

許多聽力師都有過盼著個案幾小時終於睡著不掙扎，結果沒多久後醒來又是生

龍活虎的經驗吧。 

可是怎樣叫做得出好結果？我認為好的 ABR 記錄結果有兩項重要特質：施

行檢查的聽力師自己有充分信心能判讀，以及讓其他人難以質疑聽力師的判讀

結果。雖然 ABR 歸類在客觀性檢查，但指的是受測者反應屬客觀，ABR 的判讀

反倒相當主觀，臨床聽力師通常不僅依照最後印出的反應波來判讀，還會把施

測過程中觀察到的情況如雜訊干擾、波型再現趨勢等納入考慮，許多檢查過程

中聽力師觀察到的情況最後總是因為「報告篇幅」考量而刪去，全世界除了執

行 ABR 的聽力師本人外，沒有第二個人能看見。對於所有其他閱讀這份 ABR
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報告的人來說，缺少這些檢查情況的資訊，很容易會對檢查結果提出質疑。 

曾有學者對聽力師主觀判讀 ABR 檢查結果的能力進行研究，找來一群資深

聽力師判讀一批 ABR 檢查結果，六個月後又找來同一群聽力師，判讀同一批

ABR 檢查結果，研究結果發現許多聽力師兩次判讀的結果有所出入，證實 ABR
確實在判讀上相當容易受到主觀影響。 

可想而知，如果隔了半年判讀就不同的情況是常態，ABR的效用可大有問題。

我們在自己的崗位上也許不常發生這種情況，因為我們看著自己過去下的標記，

在腦海中回想起當時特定受測者的受測情況等，有助於我們再次做出相同的判

讀，可是這些記憶只存在於我們自己腦內，其他聽力師或醫師同僚可沒有。製

作 ABR 報告時，除了要呈現判讀結果的重要資訊，也要保留會影響判讀的輔

助資訊；例如我們可能為了清楚的Ⅰ波跟Ⅴ波，選擇留下某兩條 ABR 反應波

型，但是這兩條 ABR 反應波型的Ⅲ波並不清晰，我們判定Ⅲ波位置時乃是看

到其他Ⅲ波清晰（但Ⅰ、Ⅴ波不清晰）的 ABR 反應波型，這種情況下，不妨

多留一條 ABR 反應波型下來，佐證我們對Ⅲ波的判讀。 

同樣地，當我們遇到罹患聽神經病變的個案，以不同相位刺激音記錄到很清

楚的耳蝸麥克風，也別忘了多留下一條「耳機管夾住」的反應波，佐證我們記

錄到的並非耳機電干擾。 

在臨床崗位上，我建議每隔一段時間抽閱自己或其他聽力師同僚大約半年前

執行的 ABR 檢查報告副本，試著挑戰當時的判讀，這樣的練習不但可以精進

自己執行及判讀 ABR 檢查的能力，即便真的發生半年前半年後的判讀大不相

同，不代表一定是之前有哪裡做錯，往往只是有某些重要的檢查過程資訊遺漏

所致，故可以從這樣的練習中看到有哪些資訊應該納入未來的 ABR 報告，使

其更穩固可信。 

「自己有充分信心能判讀」是 ABR「要快」的關鍵，「讓其他人難以質疑」

是 ABR「要好」的關鍵。緊接著讓我們複習有哪些 ABR 施測及記錄參數，以及

這些參數如何幫助我們把 ABR 做得又快又好。 

刺激音與傳導方式 

ABR 為聽性反應，顧名思義是要讓周邊聽覺器官對聲音刺激產生反應的檢查

方式，所以 ABR 首要考慮的參數就是刺激音與傳導方式──要用怎麼樣的聲

音、怎麼給聲音。 

目前臨床上常用的刺激音為 Click 與 Tone-Burst，另外近年來日趨成熟而能投

入臨床使用的刺激音還包括 CE-Chirp 及其變種 LS-Chirp，還有前兩種刺激音再

細分出來的 Octave Bands 版本，這幾種刺激音特性不同，用途也不同。 
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從聲學能量上來區分，Click、CE-Chirp、LS-Chirp 都是寬頻刺激音，適用於引

起較多神經同步放電的反應；Tone-Burst、CE-Chirp Octave Bands、LS-Chirp Octave 
Bands 則是窄頻刺激音，適用於需要更具頻率特定性結果的時機。 

ABR 反應波型是大量神經同步放電造成的電位變化，因此同一刻參與反應的

神經元越多，反應波波幅就會越大，能有較佳的訊噪比，故只需要較少的平均

加算速量，就可以得到清晰而有足夠信心判讀的結果。以 Click、Tone-Burst、
CE-Chirp 三種刺激音相比，CE-Chirp 引起同步放電的神經元最多，Click 次之，

Tone-Burst 最少；CE-Chirp ABR 求閾值的結果若要與行為聽閾相比較，應該會

與聽力圖上所有的頻率都有關係（目前已發表的研究都只有正常聽力耳的資料，

故還不能斷言 CE-Chirp ABR 閾值與行為聽閾的相關性），Click ABR 求閾值的結

果與行為聽力聽閾的 2K Hz～4K Hz 頻率範圍相關性最高，Tone-Burst ABR 求閾

值的結果則與行為聽閾相同頻率範圍的相關性最高。 

因此以我們目前能掌握的知識來說，CE-Chirp 可能比 Click 更適合用於新生

兒聽力篩檢，有機會用更短的時間得到篩檢結果，而且能抓出以往 aABR 容易

漏掉的中、低頻聽損個案。可惜的是 CE-Chirp ABR 缺乏聽損常模，還不適合取

代 Click 用於推估聽閾的診斷需求。 

Tone-Burst ABR 閾值具有良好的頻率特定性，與行為聽閾相關性佳，尤其對

於非極重度聽損耳，推估行為聽閾的準確性猶勝 ASSR／SSEP，是近年來發展

新生兒聽力篩檢及早療服務中相當重要的工具。但是 Tone-Burst ABR 施測相當

耗時，實務上若要求所有需推估聽閾的個案均以 Tone-Burst 刺激音施測，不但

會花費過多資源，也會因個案配合情況而難以達成。臨床實務要對時間跟結果

做出妥協，以 Tone-Burst 跟 Click 刺激音搭配求閾值的作法，目前還是相當主

流的策略。 

Click 這種寬頻刺激音雖然能量包括所有的頻率範圍，但是對 ABR 第Ⅴ波主

要貢獻來自高頻部分，因此 Click ABR 閾值跟行為聽閾的 2K Hz～4K Hz 頻率範

圍相關性最高，中低頻如 1K Hz 以下的範圍沒什麼相關。Click ABR 發展歷史悠

久，也有許多已發表的常模數值可供參考，施測耗時明顯短於 Tone-Burst ABR，
波型也比 Tone-Burst ABR 清晰易判讀，一直以來都是 ABR 求閾值的固定班底。 

不論選用何種刺激音，下一項要決定的是聲音該怎麼給。 

ABR 是對聽覺系統的一種評估方式，就跟行為聽力檢查一樣，施測條件的設

計盡可能要反映出現實生活中的情況，所以一定要獲得採氣導途徑刺激的結果。

臨床上氣導刺激建議採用插入式耳機，較不建議覆耳式耳機，因為插入式耳機

的頻率響應特性較佳、跨傳效應較輕微。採用插入式耳機執行氣導 ABR 時，

務必注意要將儀器軟體中的聲音延遲調整至 0.86 ms，得到的潛時值纔能與覆

耳式耳機得到的常模相比較；有些廠牌儀器軟體的插入式耳機預設聲音延遲為
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1.0 ms 或 0.80 ms，跟文獻上發表過的潛時相比較就會帶有出入，為了避免誤

判，一定要自己檢查過手上儀器軟體的設定是否需要再調整。 

氣導 ABR 原則上以採用插入式耳機優先，但是小耳症外耳道閉鎖的個案應

該採用覆耳式耳機，否則聲音能量很難傳入內耳引起神經衝動。單側小耳症外

耳道閉鎖的個案，一定要在非測試耳遮蔽，纔能確認反應來自測試耳；如果是

雙側小耳症外耳道閉鎖且年齡超過五個月的個案，結果應解讀為主要反應可能

來自優耳，無從得知劣耳反應。 

如果受測者的氣導 ABR 閾值並不在正常範圍內，即必須搭配骨導 ABR 閾值

確認是否存在氣骨導差距。骨導震盪器會震動整個頭顱骨，因此聲音能量很可

能同時傳至雙側內耳，記錄到的 ABR 波型不易區分是否來自測試耳，一定要

在非測試耳給予遮蔽，除非是年齡未滿五個月、頭顱骨還沒開始閉合的新生兒

則可能不需遮蔽。 

有些儀器的功能較少，例如 Cadwell Sierra Wave 同時只能連接一種換能器，

用了骨導震盪器就沒辦法接耳機，光靠儀器本身無法在施測骨導 ABR 時給予

遮蔽，有個變通的方法是取校正過的攜帶式純音聽檢儀充作遮蔽器，也就是把

攜帶式純音聽檢儀的耳機也戴到受測者頭上，僅於非測試耳固定給予遮蔽用的

噪音。遮蔽用的噪音不需要跟 ABR 儀器產生的刺激音同時開始或結束，因為

我們一開始就是希望遮蔽耳不要因刺激訊號產生反應，祇要顧好遮蔽音量即

可。 

如果無法遮蔽且受測者年齡又超過五個月，ABR 閾值結果應解讀為主要反應

可能來自優耳。 

CE-Chirp、LS-Chirp 

CE-Chirp 是種由 Claus Elberling 發展出來的 Chirp 刺激音，該刺激音專利權目

前為 William Demant Holding Group 持有，該集團旗下品牌包括 Interacoustics、
GSI、Maico 等，在不同等級的產品線均已部屬使用此刺激音，例如 Interacoustics 
Eclipse 診斷儀、GSI Audera 診斷儀、Maico MB11 新生兒聽力篩檢儀等。 

常規使用的 Click 刺激音在能量上遍及低、中、高頻率，但是行波在基底膜

行進需要時間，所以Click刺激音將先後在基底膜的基部至頂部產生最大振幅，

即先後引起高、中、低頻率的聽覺神經反應。由於 ABR 的原理在觀察神經系

統大量同步放電產生的電位變化，故若能使不同部位的神經同時產生衝動（而

非先後激發），將使 ABR 反應更為顯著，因此近十年來許多學者都在研究 Chirp
類型的刺激音，Chirp 主要概念是先計算行波在基底膜的行進速度，再據此將

一系列低、中、高頻率的聲音組合起來，使低頻部分最先進入耳內，高頻部分

最後進入耳內，同時抵達基底膜的最大振幅處，同時引起聽神經衝動。 
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其中 CE-Chirp 的特性在於頻譜與音量校準值與 100µs Click 相同，產生的波型

振幅據稱可以達 Click 的兩倍清晰。茲簡要說明 CE-Chirp 特性如下： 

 CE-Chirp 的目的是要比 Click 引起更多神經元的同步放電，採用的手段

是調整不同頻率成分的聲音能量的出現時間，讓基底膜各處能在相同時間產

生最大位移。 

 CE-Chirp 的頻率分析跟 Click 一致。 

 當刺激音強超過 60 dB nHL，CE-Chirp 引起的反應反而比 Click 不好，後

來學者根據 CE-Chirp 加以改良出 CE-ChirpLS，或稱 LS-Chirp；目前 GSI Audera
在刺激音強超過 60 dB nHL 時，會自動改用 LS-Chirp 作為刺激音。 

 對於頻率特定性的檢查，另有 CE-Chirp Octave Bands，即取出 CE-Chirp
不同頻率成分單獨使用。 

 CE-Chirp Octave Bands 的頻率分析與 2-1-2(cycle) Tone-Burst 大致相符，

但可能頻率範圍略廣一點點，也就是 CE-Chirp Octave Bands 會比 Tone-Burst
引起更多神經元同步放電，這可能是 CE-Chirp Octave Bands 能有更大Ⅴ波波

幅的來源。 

 CE-Chirp Octave Bands ABR跟Tone-Burst ABR還有一個很大的相異之處，

在於刺激音起始時間與平均加算器起始時間的差異；Tone-Burst ABR 的刺激
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音跟平均加算器會同時啟動，但是 CE-Chirp Octave Bands ABR 卻幾乎都是在

刺激音結束的時候才啟動平均加算器，因此 500 Hz CE-Chirp Octave Bands 
ABR 的Ⅴ波潛時可以出現在 3 ms 以內。 

 前述這個技術細節的差異我覺得唯一的優勢在於頻率特定性，ABR 因為

潛時隨著刺激音強減弱而大幅延長，所以在相同的分析時段設定下，可以更

清楚地看到Ⅴ波；即使用現行 ABR 儀器做 Tone-Bursts ABR，我們其實也可以

調整記錄延遲時間參數來達成相同效果。畢竟 ABR 閾值分析著重是否有可

再現之Ⅴ波出現，潛時分析不重要。 

 CE-Chirp 或 CE-Chirp Octave Bands 跟 Click 或 Tone-Burst 相比，前二者的

Ⅴ波波型都有下列特徵： 

 波幅更大 

 潛時更短 

 閾值更低 

 所需平均加算次數更少（更省時） 

 前述特徵不受刺激音相位極性或刺激速率而改變 

 由於 CE-Chirp 的設計係要引起更多神經元同步放電，因此可改善訊噪比，

甚至有看到平均加算不到 200 次時已有清晰Ⅴ波出現。 

 承上，CE-Chirp Octave Bands 甚至可用於骨導刺激，即 Bone Condition 
CE-Chirp Octave Bands ABR，仍然可以得到清晰明顯的Ⅴ波，這是以往很難有

信心施測判讀的。 

 強音強 CE-Chirp 刺激時，也有可能有非常大的Ⅵ波出現，容易誤判為Ⅴ

波，必須要根據較弱音強時的Ⅴ波來比對判斷，臨床上需多留意。 

 關於 CE-Chirp 或 CE-Chirp Octave Bands ABR Threshold 與行為聽閾相比較

的研究，目前已發表的報告仍以聽力正常耳為主，結果是 CE-Chirp 或 CE-Chirp 
Octave Bands ABR Threshold 比 Click 或 Tone-Burst ABR Threshold 可得到更佳

的閾值，但缺乏聽損耳的相關性研究，所以臨床使用上還不宜以 CE-Chirp 或

CE-Chirp Octave Bands 預估行為聽閾；目前的研究結果可以說 CE-Chirp 具有

較佳特異性，但還不能證明其具備良好敏感性。 

 CE-Chirp ABR 的Ⅰ波比 Click ABR 的不明顯，倒是 LS-Chirp ABR 的Ⅰ波比

CE-Chirp ABR 的明顯些，這些細節在臨床上也要多留意。 
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Tone-Burst ABR：頻率選擇與行為聽閾推估 

以 Tone-Burst 刺激音求 ABR 閾值時，應該做哪些頻率？早療機構通常會希望

聽力師能夠提供 500 Hz、1K Hz、2K Hz、4K Hz 等四個頻率的各耳 Tone-Burst ABR
閾值，理由是可以用這些數值來選配助聽器。不過現實是時間總是沒有理想中

充裕，如果無法求得四個頻率的 ABR 閾值，原則上至少要取得低頻範圍跟高

頻範圍各一個頻率的閾值，例如 500 Hz 跟 2K Hz，或 1K Hz 跟 4K Hz，沒有求

得的部份暫時先用內插法或外推法預估，待日後有機會再補足。 

如果使用 Tone-Burst 刺激音求 ABR 閾值之前，已經獲得 Click 刺激音的 ABR
閾值，因為 Click ABR 閾值跟行為聽閾的 2K Hz～4K Hz 部分相關性佳，倒是可

以只求 500 Hz Tone-Burst ABR 閾值，省下不少時間。 

Tone-Burst 刺激音的選用也有點學問，主要會影響 ABR 結果的參數包括刺激

音的長度及包絡。常用的 Tone-Burst 刺激音長度為 2-0-2（週期）跟 2-1-2（週

期）兩種，有些學者認為這兩種長度設定沒有明顯差異，也有些學者認為 2-1-2
平原期的那個週期纔是頻率特定性的主要貢獻者；我自己用的是 2-1-2 的設定，

但老實說我沒有實際比較過 2-0-2（週期）做出來是否真的有差異。 

理論上來說，對於 500 Hz Tone-Burst 的刺激音，2-0-2 會比 2-1-2 總長度短一

個週期，即 2 ms（1K Hz 的短 1 ms，2K Hz 的短 0.5 ms，4K Hz 的短 0.25 ms），
或許可以稍微減少反應波型混入來自刺激訊號的干擾，但 Tone-Burst ABR 反應

波型的Ⅴ波潛時常常在 10 ms 之後，不是很有必要只因為這個原因而選擇短一

個週期的刺激音。 

Tone-Burst 刺激音的包絡則在各學者研究間相當一致地選用 Blackman，這種

包絡的特色是刺激音有更佳的頻率特定性；通常 ABR 儀器的軟體還是保留諸

多不同的包絡選項，建議施測 Tone-Burst ABR 之前，先確認一下是否正確選用

了 Blackman 包絡。 
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在助聽器選配的 DSL m[i/o]處方公式軟體裡，內建以 Tone-Burst ABR 閾值推

估行為聽閾的計算公式，許多助聽器的選配軟體如 Oticon 的 Genie 等也納入這

樣的推估公式。Oticon 網站提供的《Electrophysiological Threshold Estimation and 
Infant Hearing Instrument Fitting》白皮書對這部份有加以解說，其公式如下： 

Tone-Burst ABR 閾值（dB nHL）＋校正值（dB）＝推估聽閾（dB eHL） 

頻率 500 Hz 1K Hz 2K Hz 4K Hz 
校正值（dB） -20 -15 -10 -5

舉例來說，如果有位受測者某耳 500 Hz Tone-Burst ABR 閾值為 40 dB nHL，則

該耳推估聽閾為：40＋(-20)＝20 dB eHL 

公式裡的「eHL」指的是推估聽閾 estimated Hearing Level，不是真正的行為

聽閾，運用 Tone-Burst ABR 閾值推估行為聽閾時請務必採用「dB eHL」單位，

以免跟日後實際測得的行為聽閾混淆。

刺激速率、平均加算次數、波型再現

ABR 記錄到的是神經放電引起的電位變化，這類反應平均波幅為 0.5µV，然

而背景生理雜訊的波幅平均約在 5.0µV，所以 ABR 運用平均加算的技術來提高

訊噪比。平均加算的過程中，訊號的波幅強度不變，而雜訊會隨著平均加算次

數平方根的比率遞減，經過簡單的計算，我們可以知道當平均加算達 100 次的

時候，ABR 記錄到的訊號跟雜訊波幅相當，訊噪比為 0 dB；平均加算達 400
次的時候，ABR 反應波型訊噪比為 6 dB；平均加算達 1000 次的時候，ABR 反

應波型訊噪比為 10 dB；平均加算達 2000 次的時候，ABR 反應波型訊噪比為

13 dB；訊噪比達 6 dB 時表示訊號波幅達雜訊波幅的兩倍，低於此訊噪比的記

錄結果不宜判讀，否則很容易把雜訊誤判為訊號。

前述推算還有個前提：背景雜訊相當平均且隨機地分布。如果施測 ABR 時，

受測者並不是處於相當安靜穩定的狀態，或者施測場所充斥著外部干擾，都會

讓訊噪比更惡化，因此實務上每條記錄下來的 ABR 波型應至少經過 500 次平

均加算。

先有這樣的概念後，我們再回過頭來思考刺激速率。ABR 在低刺激速率時的

波型最清楚，即訊號最強；隨著刺激速率加快，ABR 波型也會變得較模糊。 

例如某位受測者某耳 Click ABR 可能在 11.3/s 刺激速率時，經過 500 次平均

加算就能獲得清晰可判的Ⅴ波反應，當刺激速率增加到 27.7/s 時，可能需要將

近 1000 次平均加算纔能獲得清晰可判的Ⅴ波反應。 

在其他條件都保持一致不變得前提下，實際得到每一條 ABR 反應波型所需

耗用的時間恰等於平均加算次數除以刺激速率。以前面提出的例子來解釋，刺
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激速率 11.3/s 經過 500 次平均加算總共需要約 44 秒，而刺激速率 27.7/s 經過

1000 次平均加算總共需要約 36 秒，可見雖然高刺激速率需要更多次平均加算，

但整體耗時有機會再縮短。 

高刺激速率也會造成 ABR 各波潛時延長，在神經學診斷上是非常需要小心

的參數，為了能與各種文獻相比較，神經學診斷用的 ABR 在刺激速率上充滿

限制。然而對於 ABR 閾值來說，刺激速率對於Ⅴ波波幅影響不明顯，Ⅰ波、

Ⅲ波是否明顯並不重要，Ⅴ波潛時也只有在特定的情況下需要與常模仔細比較，

多數情況中祇要能確認Ⅴ波出現也有再現，就有充分信心判讀閾值結果。因此

我自己在臨床上，求取氣導 Click ABR 閾值時，多採用相當激進的 57.7/s 刺激

速率，及 2000 次平均加算設定，完成一條 ABR 波型的總耗時約為 35 秒。 

臨床實際施測 ABR 時，不論是環境雜訊或受測者生理性雜訊等，都不如理

論上那般平穩理想，所以即使用 11.3/s 刺激速率，也可能需要 700～1000 次平

均加算（總耗時 62～89 秒），27.7/s 刺激速率也可能需要 1500～2000 次平均

加算（總耗時 54～72 秒），57.7/s 刺激速率也可能需要到 2500～3000 次平均

加算（總耗時 43～52 秒），在這種實際的情況中，選用較高刺激速率所能節省

的時間也會更加顯著。當然刺激速率不能無止盡地提高，除非打算以頻域分析

（一般 ABR 波型以時域分析），否則不建議使用超過 60/s 的刺激速率。 

無論選用多快多慢的刺激速率，發現達到預期的平均加算次數後仍然沒有足

夠清晰可判的 ABR 波型時，都可以選擇增加平均加算次數，或選擇再記錄另

一條 ABR 波型。這個選擇取決於施測過程中是否有明顯的偶發雜訊事件發生，

例如受測者翻身、抓癢、打噴嚏等，或者儀器電路系統突然遭遇干擾等；因為

這類偶發雜訊事件導入的雜訊跟平均分布的雜訊不同，要靠平均加算來改善訊

噪比相當不易，不如直接重新來過。 

如果是經常出現但穩定發生的雜訊來源，倘若真的無法排除，倒是可以用增

加平均加算次數的方法，來改善訊噪比。無論如何，平均加算次數超過 3000
次之後的改善效益已經小到很不划算的地步，建議該記錄另一條 ABR 反應波

型了。 

用兩條或多條 ABR 反應波型來證實再現性，也是臨床上 ABR 常用的技巧。

原則上對於任何 ABR 反應波型，都要證實其再現性，纔有足夠的信心說記錄

到的結果是訊號而非雜訊；唯一可省略再現波步驟的情況是求閾值時，已求得

高音強有再現之 ABR 第Ⅴ波反應後，以不超過 10 dB 步幅逐漸降低音強找Ⅴ波

反應的各 ABR 波型，此時係以較高音強的 ABR 波型來佐證Ⅴ波出現潛時及波

型型態是否合理。 

然而即使在這種運用方式中，一開始的高音強 ABR 仍需有兩條以上的反應

波型證明其再現，做為整份 ABR 結果判讀的信心基礎；而接近閾值時隨著Ⅴ
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波越來越不明顯，也都需要兩條以上的反應波型證明其再現，如此記錄下來的

結果纔真的是牢不可破。 

相位與濾波器 

ABR 的刺激音相位參數與記錄時的濾波器參數完全是兩個東西，但因對 ABR
結果記錄的影響相關，在此一起討論。 

不論是 Click、Tone-Burst、CE-Chirp 或任何刺激音，都有三種不同的相位設

定：密波先行、疏波先行、疏密波交替。有學者認為密波先行可以得到較大的

Ⅴ波波幅，疏波先行則可以得到較大的Ⅰ波波幅；疏密波交替則可以獲得較佳

的訊噪比，但因各波潛時在疏波與密波均有差異，所以交替平均之下各波波幅

會較小，波峰較不明確，耳蝸麥克風也會因相位相反而彼此抵消。 

除此之外也要注意，雖然密波先行通常可以得到較大的Ⅴ波波幅，但有某些

個案以密波先行的測試音施測 ABR 時，Ⅴ波波幅反而會變小甚至完全消失，

改用疏波先行的相位設定後則Ⅴ波恢復出現。 

實務上設計施測參數時，考慮到前述種種研究結論，平常求氣導 Click ABR
閾值時，因為目標是想要有更清楚的Ⅴ波反應可判讀，故我以採用密波先行的

相位設定為主，如果以最高音強施測仍不見Ⅴ波出現，或者施測音強跟其他聽

力學資訊比較已經達到不尋常的音量，或者需要以Ⅰ波確認反應來自受測耳，

即更換改為疏波先行施測；如果施測時發現 ABR 波型訊噪比不佳，則更換為

疏密波交替。求 Tone-Burst ABR 閾值或骨導 Click ABR 閾值時，因為很容易受到

來自耳機或肌肉的雜訊干擾，則一律採用疏密交替波施測。 

求 ABR 閾值時，主要以Ⅴ波反應作為判定目標，越能清楚地指認Ⅴ波，就

越能縮短詩測時間。除了利用相位變化來增大Ⅴ波反應或使其更為明確，也可

以在記錄 ABR 反應波型時，調整濾波器設定來輔助判讀。 

ABR 儀器通常以高通濾波器及低通濾波器組合成帶通濾波器，高通濾波器指

的是高於多少 Hz 以上的頻率能量可以通過納入波型，低通濾波器指的是低於

多少 Hz 以下的頻率能量可以通過納入波型。再一次地，當我們求 ABR 閾值時，

想要看到清晰可判的Ⅴ波反應，透過濾波器有兩個方法能夠改善Ⅴ波反應，分

別是把高通濾波器設低，以及把低通濾波器設高。 

高通濾波器設低時，會帶入更多的低頻波型；Ⅴ波的負波即是低頻波型，而

Ⅴ波負波又是判別Ⅴ波的重要依據，所以高通濾波器設低可以讓Ⅴ波的出現與

否更清楚。 

低通濾波器設高時，會帶入更多的高頻波型；ABR 各波的波峰在高頻波型能

量充足的時候，會更為精確，包括Ⅴ波的波峰也會更明顯，與Ⅳ波波峰也較可
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區辨。不過別忘了，求 ABR 閾值時，Ⅴ波潛時並不是關鍵資訊，不需要過於

斤斤計較，所以祇要懷疑雜訊可能導致Ⅴ波誤判，寧可調低低通濾波器；例如

於嬰幼兒受測者施測 ABR 時，低通濾波器的設定就會低於成人受測者的情況。 

高通濾波器設低，低波濾波器又設高，另一個作用是雜訊更容易混入反應波

型，導致 ABR 波型訊噪比變差。ABR 很常受到下列這些電流雜訊干擾： 

 進行中的腦波：30 Hz 以下 

 肌原性干擾：100 Hz～500 Hz 為主，可能的分佈範圍達到 5000 Hz 以上 

 皮膚電位：0.05 Hz～30 Hz 

 交流電源：60 Hz 

 儀器干擾：10000 Hz 以上 

為了要盡量避開這些干擾，又要盡量讓Ⅴ波反應明顯，建議高通濾波器設在

30 Hz，低通濾波器則設在 3000 Hz（嬰幼兒個案可以設在 1500 Hz 或 1000 Hz）。 

濾波器跟相位設定一樣，不是設定了就不得動彈；例如在 ABR 施測過程中，

偶爾會出現難以排除的肌原性干擾，嚴重影響Ⅴ波判定，這種時候可以修改濾

波器設定避開干擾波的頻率範圍再記錄一條 ABR 波型，與原本的波型一起判

讀，即可擔保判讀的有效性，待干擾減輕或消失後再把濾波器設定調回一開始

的設定，就不會浪費到時間。 

肌原性干擾波很容易發現，其波幅大而且週期很固定，遍及整個 ABR 分析

時段，波型則很像正弦波或三角波，波峰波谷都相當尖銳。發現這種干擾波時，

首先估算其波峰的潛時間隔，可得干擾波週期，再用 1000 毫秒（等於 1 秒）

除以週期即可得到其頻率。例如發現有肌原性干擾波，其相鄰兩波峰間隔約 4 
ms，表示這個干擾波的頻率約為 1000 ms÷4 ms＝250 Hz；接著可以試著把濾

波器分別調整為 30 Hz～200 Hz，以及 300 Hz～3000 Hz，干擾波的影響應該都

會大幅減輕，而這兩條 ABR 波型仍然可以合併判讀找出Ⅴ波負波及Ⅴ波波峰

的大略位置。 

分析時段與時間解析度 

ABR 記錄的分析時段與時間解析度乃是一體的兩面，分析時段越長（越寬）

則時間解析度越差。如果施測 ABR 的目的需要精確的各波潛時，時間解析度

至關重要；反之若施測 ABR 並不需要精確的各波潛時，有需要的話可以稍微

犧牲時間解析度，換來更充裕的分析時段。 

ABR 分析時段要多寬，主要是按照各波潛時的分佈常模決定。例如用於神經
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診斷時的 ABR 係以高刺激音強施測，各波反應都在 10 ms 以內結束，故將分析

時段設定在 10 ms，以獲得最佳的時間解析度。可是求 ABR 閾值時則不適合用

這樣的設定，因為隨著施測音量趨近閾值，Ⅴ波潛時也會延長；如果運用加快

刺激速率等策略，Ⅴ波潛時會延長更多。更重要的是，分析時段只夠看到波峰

並不夠，必須要能看到完整的各波反應，包括完整的Ⅴ波負波，判定 ABR 閾

值時纔有充分信心與效力。 

我的 Click ABR 閾值分析時段設在 15 ms，Tone-Burst ABR 閾值分析時段則是

30 ms；我建議 Click ABR 閾值分析時段應至少達 12 ms，Tone-Burst ABR 閾值分

析時段則應至少達 25 ms 纔夠。如果搭配記錄延遲時間的設定，倒是可以把分

析時段縮短。 

應該把分析時段設到多寬，也跟刺激速率的選用有關。如果分析時段設得太

寬，會看到下一次刺激音的波型及隨之而來的反應混入其中。除非刻意要用來

施測穩定狀態反應，否則這樣的配置容易產生誤解及混淆，應該盡量避免。 

分析時段跟刺激速率的關係應滿足下列的關係式： 

分析時段（ms）＜1000÷刺激速率（1/s） 

例如以 27.7/s 刺激速率施測 ABR 時，分析時段應不超過 36 ms；以 57.7/s 刺
激速率施測 ABR 時，分析時段應不超過 17 ms。反之若先決定分析時段，也可

以用等義的下列關係式判斷可用的刺激速率上限： 

刺激速率（1/s）＜1000÷分析時段（ms） 

例如分析時段設定在 30 ms 時，刺激速率應不超過 33.3/s。 

雜訊拒斥與耳後肌電位 

臨床施測 ABR 時，除了先前提及偶發的外部干擾波、可能持續的肌原干擾

波，也很常遇到受測者明明處於穩定安靜（甚至已經熟睡）狀態，偏偏儀器不

斷回報雜訊拒斥，使得施測進度停滯不前。如果所有可能的干擾俱已排除，很

有可能是該個案的反應波波幅超乎常人地巨大。 

遇到這種情況時，可視情況稍微放寬雜訊拒斥閾，使雜訊拒斥率略低於 10%
時最為理想。如果放寬雜訊拒斥閾後發現反應波型裡不易判定 ABR 各波，也

可以考慮增加平均加算次數。最終得到的結果或許反應波型訊噪比不算相當好，

但至少比沒有結果好。 

另一個臨床上相當常遇到的干擾波是耳後肌反應，其波幅極大，遠超出Ⅴ波

可能之波幅，而且通常出現在 10 ms 之後，不會跟 ABR 各波混淆，可以加註

PAM（耳後肌）後於判讀時忽略。如果耳後肌反應真的干擾到 ABR 判讀，還有
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幾個應變方法：調整受測者的頭頸部姿態，例如調整枕頭的高度或位置等，使

受測者頭頸部更為放鬆，有助於減輕耳後肌反應。降低刺激音量，也可以減輕

耳後肌反應；例如以 80 dB nHL 音量施測時有很大的耳後肌反應影響判讀，不

妨直接降到 60 dB nHL 施測看看，如果此時能有可靠的Ⅴ波反應，就以此為依

據繼續調降施測音量。把耳後電極（A1、A2）從乳突改黏貼到耳垂後側，或使

用耳道電極等方法，可以使記錄電極離開耳後肌，也有助於減輕耳後肌反應。 

施測音強步幅 

施測音強步幅有兩套策略，各有不少擁護者。一種策略是先採用30 dB步幅，

靠近閾值時再降至 10 dB 甚至 5 dB 步幅增減；另一種策略是只有一開始採用

30 dB 步幅，或者直接從最高刺激音強開始，接著都以 10 dB 步幅遞減，靠近

閾值時再採用 5 dB 步幅。 

乍看之下第一種策略需施測的音強數量較少，好像比較快，但是第二種策略

可以節省確認波型再現的時間，所以實際上兩種策略需記錄下來的 ABR 反應

波型數量差距不大。請參考下表分析： 

閾值 策略 施測音強過程 次數 

90 A、B 60 (2)→90 (2)→80 (2) 6 

80 A、B 60 (2)→90 (2)→80 (1)→70 (2)→80 (1) 8 

70 A、B 60 (2)→90 (2)→80 (1)→70 (1)→60 (2)→70 (1) 9 

60 A、B 60 (2)→50 (2) 4 

50 A 60 (2)→30 (2)→50 (1)→40 (2)→50 (1) 8 

B 60 (2)→50 (1)→40 (2)→50 (1) 6 

40 A 60 (2)→30 (2)→50 (1)→40 (2) 7 

B 60 (2)→50 (1)→40 (1)→30 (2)→40 (1) 7 

30 A 60 (2)→30 (2)→20 (2) 6 

B 60 (2)→50 (1)→40 (1)→30 (1)→20 (2)→30 (1) 8 

20 A 60 (2)→30 (2)→20 (1)→10 (2)→20 (1) 8 

B 60 (2)→50 (1)→40 (1)→30 (1)→20 (1) →10 (2)→20 (1) 9 
這是相當理想情況下的次數分析，實際上兩套不同策略會遇到的 ABR 波型

判讀挑戰不同，第一種策略（A）在 60 dB nHL、90 dB nHL、30 dB nHL 這幾次

的波型判讀上常常是全新的開始，考驗聽力師對不同音強下的 ABR 波型型態

熟悉程度；第二種策略（B）有時候會把雜訊誤判為Ⅴ波，考驗聽力師對潛時

變化及波型型態的敏感程度。端看施測的聽力師對哪一套策略下的判讀模式較

有把握、比較自在，即可選用對應的策略。 
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風水與環境干擾 

施測 ABR 時最怕沒來由的環境電磁干擾，明明檢查室都加上銅網屏蔽，受

測者也睡到不省人事，偏偏儀器上還是顯示出奇怪的、非生理性的干擾波型。

這種讓人摸不著頭緒的干擾，姑且說是風水不好吧。 

既然風水不好，就從改風水開始。諸如檢查床的擺設位置與角度、儀器擺設

的位置與角度、耳機線及電極線路的走位等，不妨都做些調整，也許干擾就會

消失。如果有尚未關機的通訊設備，例如行動電話、平板電腦、股票機、呼叫

器等，也務必全面關機；因為在收訊不良的檢查室內，這些通訊設備會自動加

大傳輸功率，導致更容易影響 ABR 儀器運作，這可就不能怪到風水上頭。 

最後別忘了，如果干擾波的頻率固定，還可以參照先前說明過的改變濾波器

設定，也能夠減輕干擾。 

電極位置與走線 

記錄電極在擺放時也應該要盡量遠離耳機或耳機線，因為耳機的電訊號也可

能對記錄電極產生干擾。 

如果只打算施測氣導 ABR，耳後電極（A1、A2）可黏貼在乳突處，因距離耳

蝸較近可以獲得較清晰的紀錄結果；但如果有打算或有可能需要施測骨導 ABR，
一開始就該把電極貼在耳垂後側，把乳突留給骨導震盪器。四條電極線也可以

像綁辮子般互相纏繞，有助於減輕環境雜訊干擾；走線也要注意，盡量避免讓

線材路經可能產生電流干擾或可能帶靜電的物體附近。 

潛時─音強函數關係與運用 

ABR 各波的潛時─音強函數關係是判讀 ABR 記錄結果的重要工具，其中尤以

Ⅴ波的潛時─音強函數關係最為重要，可以用來協助鑒別診斷可能的聽損原因

或病灶。通常 ABR 的潛時─音強函數關係乃是與常模資料相比較，依平均值

正負兩個或三個標準差為正常區間；採用兩個標準差的偽陽性偏高，採用三個

標準差的偽陰性偏高，可惜沒有兩全其美的辦法。 

但是要注意各常模都有自己的年齡、性別、施測記錄參數，必須要與常模一

致的資料纔能直接套用。例如以下這份是年輕成年正常女性以 Click 刺激音採

27.7/s 刺激速率在不同刺激音量所得到的正常範圍，淺灰線是兩個標準差，深

灰線是三個標準差。 
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潛時─音強函數關係不只能用於神經學診斷，也可以用於求閾值。在 ABR

求閾值又要快又要好的這個目標中，如果我們不用真的找出受測者的確切 ABR
閾值，而能夠在某個地方就打住並且有信心地說其聽覺系統對聲音刺激的反應

落於正常範圍內，勢必可以再省下不少時間。 

實現這個夢想的工具正是潛時─音強函數關係的正常值範圍。然而不幸地，

我們在前面幾節運用種種方法想更快求得 ABR 閾值，代價是我們在過程中可

能操弄了許多施測記錄參數，因而難以直接比對現有已發表的正常值範圍。 

可是我們還是想要善用這些已發表的資料，該怎麼辦？一種方法是我們在以

30 dB nHL 或 20 dB nHL 音量施測時，退一步採用與標準常模相符的施測參數，

另一種方法是全程改採與標準常模相符的施測參數；前者較省時但可能會有盲

點，後者較費時但判讀上會更具信心。當然最好的辦法是按照自己常用的參數

配置，統計自己的正常值範圍，短期來說當然很辛苦，長期來說絕對有其價值，

不會白白浪費。 
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40Hz MLR 技術 

40 Hz MLR 閾值係 ABR 特殊檢查技巧，為中潛時之穩定狀態反應，利用 MLR
兩個主要反應波潛時約相差 25 ms 之特性，疊加刺激速率約 40/s（即每 25 ms
產生一次刺激）之多次刺激反應波，得到整體為 40 Hz 波型之結果。此技巧名

稱中的「40 Hz」係描述反應波波型，與施測用的刺激音無關；如果以 500 Hz 
Tone-Burst 刺激音得到 40 Hz MLR 反應，可推論負責 500 Hz 聽覺之周邊聽覺器

官、聽神經等已將聲音訊息轉為神經衝動往中樞傳遞，此時檢查的結果可與

500 Hz 純音聽閾相比較。 

40 Hz MLR Threshold 最主要的優點為：反應波波幅大，即使接近閾值也很明

顯；需平均加算之次數少，大約 100 至 200 次就足夠，故施測時間短，平均約

三至五分鐘即可求得雙耳閾值。 

但是這項技術也有著相當的缺點，導致臨床上不常使用：40 Hz MLR 與中樞

神經系統成熟度有關，所以兒童或嬰幼兒身上無法測得；40 Hz MLR 也會受到

睡眠深度或鎮靜藥物影響，必須要在受測者保有清醒神智的時候施測。 

臨床上常以 ABR 閾值比對行為純音聽閾判讀，尤其是對行為反應可靠性存

疑者，例如嬰幼兒個案及欲申請鑑定之個案。嬰幼兒個案通常會求 Click ABR
閾值及 500 Hz Tone-Burst ABR 閾值，對成人個案則常只求 Click ABR 閾值，表示

後者只能獲得高頻部分的資訊（因 Click ABR 閾值僅與 2K Hz～4K Hz 之純音聽

閾相關性較高），對低頻部分之聽閾難以確認。所有的個案常規求 500 Hz 
Tone-Burst ABR 閾值顯然不切實際，花費太多時間，但若考慮搭配 500 Hz 
Tone-Burst 40 Hz MLR 閾值，可很快得到低頻聲音刺激的電生理反應，彌補其

不足；至於 40 Hz MLR 閾值的施測時機則可以考慮放在 ABR 閾值之前，如此可

避開受測者入睡程度對 MLR 的影響。 

500 Hz Tone-Burst 40 Hz MLR 閾值的施測參數可參考下列設定： 

 刺激音類型：Tone-Burst 

 刺激音中心頻率：500 Hz 

 刺激音長度：2-0-2（週期） 

 刺激音包絡：Blackman 

 刺激音相位：密波先行 

 刺激速率：37.1/s 

 平均加算次數：200 
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 高通濾波器：10 Hz 

 低通濾波器：100 Hz 

 分析時段：100 ms 

按照這樣的設定，現成的 ABR 儀器就可以用來施測求 40 Hz MLR 閾值；只要

看到大約間隔 25 ms 的四個反應波波峰，就表示該刺激音量有反應，逐步降至

仍有反應的最小音量，即為閾值。例如以下這名個案的左、右耳 500 Hz 
Tone-Burst 40 Hz MLR 閾值分別為 40 dB nHL 及 30 dB nHL： 

 

儘管 40 Hz MLR 的威力不如 Tone-Burst ABR，但其省時迅速的特性，或許能

在意想不到的場合發揮功效，值得花點時間熟悉。 
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0 dB nHL 行為校正 

ABR 施測音量常用的單位是「dB nHL」，因為 Click 短聲無法按照純音的方式

校正，故只能以行為方式校正，作為替代基準。然而許多醫療院所購置 ABR
儀器之後，並沒有實際以行為方式校正輸出音量，直接採用儀器內預先設定好

的「dB nHL」基準使用；但儀器廠商在儀器的製造過程中也不會採用行為校正，

而是以 dB peSPL 或 dB pSP 等替代基準校正，再套用儀器校正值的對照表換算

得到 0 dB nHL 的音量基準。 

因此臨床上直接採用儀器內設的 dB nHL 基準相當危險，特別是要與其他文

獻中發佈的常模相比較，往往造成誤判而不自知。 

醫療院所鮮少有校正 ABR 儀器的原因倒也不難理解，因為實際上要如教科

書所描述那般「找 20 位 18 至 25 歲雙耳平均聽閾 0 dB HL 且無耳科或聽力相

關病史的正常志願者，男女各佔半數」來進行行為校正，可以說是不可能辦到。 

即使如此，身為專業的臨床聽力師，還是應該負起校正 ABR 音量的重責大

任。我在本院放寬標準，找到「20 位 18 至 40 歲雙耳 500 Hz、1K Hz、2K Hz、
4K Hz 氣導及骨導聽閾均優於 20 dB HL 的聽力正常志願者」，協助進行 ABR 刺

激音量的行為校正。 

首先以 5 dB 步幅記錄這 20 位聽力正常志願者的各耳氣導 500 Hz、1K Hz、2K 
Hz、4K Hz 聽閾，以及這 20 位聽力正常志願者優耳的骨導 500 Hz、1K Hz、2K Hz、
4K Hz 聽閾，並先計算出這四個頻率的平均聽閾。 

接著再請這20位聽力正常志願者分別至ABR檢查地點，分別以插入式耳機、

覆耳型耳機、骨導震盪器，同樣依 5 dB 步幅記錄他們雙耳氣導以及優耳骨導

所能聽到儀器輸出最小的 Click 及 Tone-Burst 刺激音音量顯示值為何。所有完

成這些程序的志願者，均由本院聽力室贈送價值約新台幣一百元的小禮物作為

感謝。 

第三步是把所有志願者的平均聽閾再加總取平均，ABR 儀器可聽到最小刺激

音音量顯示值也一樣加總取平均。如此 Click 的平均音量顯示值與 500 Hz、1K Hz、
2K Hz、4K Hz 平均行為聽閾相比，Tone-Burst 的平均音量顯示值則與對應頻率

的行為聽閾平均值相比，氣導比氣導、骨導比骨導，就知道儀器的設定值跟真

正的 0 dB nHL 相差多少。 
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本院的校正結果顯示，500 Hz Tone-Burst 的輸出音量與行為聽閾平均值僅相

差 1 dB，可見儀器校正的結果對於這種較長的刺激音可說相當精確。但是 Click
的結果就有差距了，骨導震盪器的輸出與行為聽閾平均值相差 3 dB，插入式耳

機與行為聽閾平均值相差 6 dB，覆耳式耳機與行為聽閾相差 10 dB！ 

由這樣的經驗可知，實在是不能相信儀器內設置的 dB nHL 基準，一定要親

自做過行為校正，求得的 ABR 閾值或 ABR 潛時值纔能拿出來跟其他發表在期

刊文獻上的數據比對應證。 

常模 

既然 0 dB nHL 應該要自己做行為校正，ABR 的反應波各項數值也最好能自己

建立常模；主要的原因包括人種差異可能造成的影響，以及慣用施測及記錄參

數的不同。建立常模是比行為校正更加艱辛的工作，理想中不但要按照性別分

組，也要根據不同年齡分組，嬰幼兒的部份甚至需要按月或發展週數來分組。 

在還沒有辦法累積足夠的個案量前，不得已只好使用其他學者已發表的常模

資料，此時就要特別留意不同常模所使用的施測條件及參數，以及適用的性別

及年齡分組。以下列出一些常模供參考： 
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附錄：摘要速查 

Cadwell Sierra Wave 哪裡改設定 

Edit→Test Menu 
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GSI Audera 哪裡改設定 

Tests→Edit AEP Test Sets 
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HIS SmartEP 哪裡改設定 

Stimulus→Select Stimulus 

 

Protocol→Setup Protocol 
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System→Amplifier Settings 
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Interacoustics Eclipse 哪裡改設定 

File→System setup→Auto Protocols 

 

File→System setup→Latency Template 
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刺激音與傳導方式選擇 

 篩檢：CE-Chirp（LS-Chirp）、Click 
 檢核行為聽閾：Click 
 推估行為聽閾：Click＋Tone-Burst 
 傳導方式：氣導必測，骨導輔助 
 耳機：插入優先，閉鎖覆耳 
 骨導遮蔽：五個月以上 

Tone-Burst 刺激音 

 選用頻率：Click＋500 Hz、500 Hz＋2K Hz、1K Hz＋4K Hz，三組擇一 
 刺激音長度：2-1-2 (cycles)、2-0-2 (cycles)，兩組擇一 
 刺激音包絡：Blackman 
 推估行為聽閾： 

Tone-Burst ABR 閾值（dB nHL）＋校正值（dB）＝推估聽閾（dB eHL） 

頻率 500 Hz 1K Hz 2K Hz 4K Hz 
校正值（dB） -20 -15 -10 -5 

 

刺激速率、平均加算次數、波型再現 

 刺激速率低可獲得較佳的反應波型，但較耗時 
 平均加算次數越多，可獲得越佳的訊噪比，但較耗時 
 用於神經學診斷，刺激速率＜20/s 
 用於求閾值，20/s＜刺激速率＜60/s 
 平均加算次數至少要達 500 次左右，超過 3000 次實在太耗時 
 至少要有兩條相符的波型證實再現性，纔能建立初始的判讀信心 
 ABR SNR＝10×㏒(平均加算次數)-20 
 得到反應波型耗用時間＝平均加算次數÷刺激速率 
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相位與濾波器 

 密波先行通常有較大的Ⅴ波 
 但有些受測者密波先行反而Ⅴ波反應很小或消失，需換以疏波先行 
 疏波先行通常有較大的Ⅰ波 
 疏密交替波可以獲得較佳的訊雜比，但是各波波幅會較小，耳蝸麥克

風會消失 
 高通濾波器設低，可以獲得較大的Ⅴ波負波 
 低通濾波器設高，可以獲得較清晰的各波波峰 
 一定要用疏密交替波的情況： 

 Tone-Burst 
 骨導 

 常見的電流雜訊干擾： 
 進行中的腦波：30 Hz 以下 
 肌原性干擾：100 Hz～500 Hz 為主，可能達到 5000 Hz 以上 
 皮膚電位：0.05 Hz～30 Hz 
 交流電源：60 Hz 
 儀器干擾：10000 Hz 以上 

 建議的濾波器設定值： 
 成人：30 Hz～3000 Hz 
 嬰幼兒：30 Hz～1500 Hz 或 30 Hz～1000 Hz 

分析時段與時間解析度 

 分析時段應要能看到完整的各波反應，只看到波峰不夠 
 分析時段越寬，時間解析度越差 
 分析時段應小於刺激週期，否則會看到下一個刺激音波型混入 
 分析時段（ms）＜1000÷刺激速率（1/s） 
 刺激速率（1/s）＜1000÷分析時段（ms） 
 分析時段建議設定： 

 成人氣導 Click：12 ms 
 嬰幼兒氣導 Click：15 ms 
 成人氣導 Tone-Burst：25 ms 
 嬰幼兒氣導 Tone-Burst：30 ms 
 嬰幼兒骨導 Click：25 ms 
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雜訊拒斥與耳後肌電位 

 雜訊拒斥閾可視情況放寬，使雜訊拒斥率略低於 10% 
 耳後肌反應通常出現在 10 ms 之後，如果不會干擾Ⅴ波判讀信心，可

以不理會 
 調整枕頭或降低刺激音量都可能減弱耳後肌反應 
 改變電極黏貼位置到耳垂後側也可以避免耳後肌反應 
 考慮雜訊拒斥後，波型耗用時間＝ 

平均加算次數÷刺激速率÷(1-雜訊拒斥率) 

風水與環境干擾 

 改變床位 
 改變儀器位置 
 改變線路走位 
 改變濾波器設定 

電極位置與走線 

 耳機與電極錯開 
 只做氣導時，電極貼乳突 
 計畫做骨導，電極貼耳垂後面 
 電極線互纏，勿路過可能有電流干擾的物體附近 

比對常模需注意事項 

 性別 
 參數 
 音強單位 

 dB nHL 
 dB peSPL 
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500 Hz Tone-Burst 40 Hz MLR 閾值施測參數 

 刺激音類型：Tone-Burst 
 刺激音中心頻率：500 Hz 
 刺激音長度：2-0-2 (cycles) 
 刺激音包絡：Blackman 
 刺激音相位：Condensation 
 刺激速率：37.1/s 
 平均加算次數：200 
 高通濾波器：10 Hz 
 低通濾波器：100 Hz 
 分析時段：100 ms 

實機演練 

 變更刺激音種類 
 改變 Tone-Burst 參數 
 變更刺激音傳導途徑 
 插入式耳機聲波延遲設定 
 改變平均加算次數設定 
 改變刺激速率設定 
 改變刺激音相位 
 改變濾波器設定 
 改變分析時段設定 
 改變雜訊拒斥閾設定 
 建立 500 Hz Tone-Burst 40 Hz MLR 閾值施測程序 
 Click 刺激音 0 dB nHL 行為校正 
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